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MINDI™ ACTIVE FILTER DESIGNER
USER’S GUIDE
Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
Mindi™ Active Filter Designer & Simulator. Items discussed in this chapter include:
• Document Layout
• Conventions Used in this Guide
• The Microchip Web Site
• Customer Support
• Document Revision History

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 
Select the Help menu, and then Topics to open a list of available on-line help files.
© 2008 Microchip Technology Inc. DS51666B-page 1



Mindi™ Active Filter Designer User’s Guide
DOCUMENT LAYOUT
This document describes how to use the Mindi™ Active Filter Designer & Simulator as 
a development tool to emulate and debug firmware on a target board. The manual 
layout is as follows:
• Chapter 1. “Overview” – this chapter provides an overview of the Mindi™ Active 

Filter Designer & Simulator.
• Chapter 2. “Filter Design Tutorial” –  this chapter provides a filter design 

example.
• Chapter 3. “Filter Requirements” – this chapter discusses the desired 

parameters for the filter.
• Chapter 4. “Advanced Options” – this chapter discusses the filter topologies 

and the  specifications of components to be used in the filter circuit.
• Chapter 5. “Op Amp Selection” – this chapter discusses the selection of op 

amps to be used in the filter design.
• Chapter 6. “Analyze” – this chapter discusses the analysis of the filter and 

displays the filter response.
• Appendix A. “Filter Magnitude Templates” – this chapter gives an introduction 

of the filter magnitude templates such as low-pass filter template, band-pass filter 
template and high-pass filter template.

• Appendix B. “Low-Pass Filter Approximations” – this chapter discusses the 
characteristics of the filter approximations supported by the Mindi™ Active Filter 
Designer & Simulator in greater detail.

• Appendix C. “Op Amp Selection” – this chapter discusses how to select the op 
amps for your filter to avoid problems with non-linear distortion and filter response 
distortion.

• Appendix D. “Group Delay” – this chapter discusses Group Delay and focuses 
on the relative delay among sine waves of nearly equal frequency.

• Appendix E. “Selected References” – this chapter provides a list of reference 
material on filter textbooks and classic references as well as application notes.
DS51666B-page 2 © 2008 Microchip Technology Inc.



Preface
CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat
File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-
Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

© 2008 Microchip Technology Inc. DS51666B-page 3



Mindi™ Active Filter Designer User’s Guide
THE MICROCHIP WEB SITE
Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the web site at: http://support.microchip.com.

DOCUMENT REVISION HISTORY

Revision B (December 2008)
• Updated the tool’s name to Mindi™ Active Filter Designer & Simulator.
• Updated the Figures through the User Guide.

Revision A (June 2007)
• Initial Release of this Document.
DS51666B-page 4 © 2008 Microchip Technology Inc.
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MINDI™ ACTIVE FILTER DESIGNER
USER’S GUIDE
Chapter 1.  Overview
1.1 INTRODUCTION
The Mindi™ Active Filter Designer & Simulator is an Application Circuit within the 
Mindi™ Circuit Designer & Simulator, which is available on the Microchip home page 
(http://www.microchip.com) under “Analog Design & Sim. Tool” or going directly to 
the Mindi home page (http://www.microchip.com/mindi). The Mindi™ Circuit Designer 
& Simulator provides full schematic diagrams of the active filter circuit with 
recommended component values and displays the signal responses in frequency and 
time domains.
The Mindi™ Active Filter Designer & Simulator allows the design of low-pass filters up 
to an 8th order filter with Chebychev, Bessel or Butterworth approximations from 
frequencies of 0.1 Hz to 1 MHz. It also can be used to design band-pass and high-pass 
filters with Chebychev and Butterworth approximations. The circuit topologies 
supported by the tool are the Sallen Key and Multiple Feedback (MFB). The low-pass 
filters can use either the Sallen Key or MFB, the band-pass filter is available with the 
MFB and the high-pass filter uses the Sallen Key.
Users can select a flat pass-band or sharp transition from pass-band to stop-band. 
Other options, such as minimum ripple factor, sharp transition and linear phase delays 
are available. Once the filter characteristics have been identified, the Mindi™ Active 
Filter Designer & Simulator can generate and simulate the schematic of filter circuit. For 
maximum design flexibility, changes in resistor and capacitor values can be 
implemented to fit the demands of the application. The tool will recalculate all values to 
meet the desired response, allowing real-world values to be substituted or changed as 
part of the design process. The tool also generates a Bill of Materials (BOM) of the 
designed filter. Users can directly order the op amps and evaluation boards from the 
Microchip web site at www.microchip.com.
© 2008 Microchip Technology Inc. DS51666B-page 5
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1.2 ACCESSING MINDI™
The Mindi™ Circuit Designer & Simulator can be accessed on Microchip’s Home Page 
(http://www.microchip.com) under “Analog Design & Sim. Tool” or by going directly 
to the Mindi™ Home web page (http://www.microchip.com/mindi).
 

FIGURE 1-1: Mindi™ can be accessed on the Microchip Home Page.
DS51666B-page 6 © 2008 Microchip Technology Inc.
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Overview
The Mindi™ Home Page is shown in Figure 1-2. To enter the Mindi™ Circuit Designer 
& Simulator, click the Click Here to Start button in the window.

FIGURE 1-2: Bring up the Mindi™ Circuit Designer & Simulator on the Mindi™ 
Home Page.

Once users log onto Mindi™, the home page is displayed, indicating the application 
circuits that are available for design and simulation, as shown in Figure 1-3. The Active 
Filters button is indicated in the upper-left corner of the web page. Click on it to enter 
the active filter online design and simulation test environment.
The first time Active Filters accessed, users will be prompted to provide some basic 
registration informatio, as shown in Figure 1-4. Once registered, an account is created 
on the Host Server and users will be able to generate and analyze designs on the 
Mindi™ Circuit Designer & Simulator web page. Custom designs can also be saved to 
users’ PC, where they can be accessed for future reference.

Note: If a Pop-Up Blocker is enabled on the users’ browser, there may be a 
problem with the registration process. Please be sure to disable this feature 
when registering on Mindi™. On Internet Explorer, this is done by selecting 
the Pop-Up Blocker window under the Tools pull-down menu.
© 2008 Microchip Technology Inc. DS51666B-page 7
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FIGURE 1-3: Application Circuit.

FIGURE 1-4: New User Registration.
DS51666B-page 8 © 2008 Microchip Technology Inc.



Overview
1.3 ACTIVE FILTER DESIGN
The Mindi™ Active Filter Designer & Simulator has five filter design tabs which include 
Application Circuit, Filter Requirement, Advanced Options, Op Amp Selection, 
Analyze, as shown on the Tab bar on the top of the tool page in Figure 1-5. These tabs 
enable the user to move through the design steps of specifying performance 
requirements. An overview of the Mindi™ Active Filter Designer & Simulator is given in 
the following sections.

1.3.1 Application Circuit Tab
The active filter design starts from the Application Circuit tab (see Figure 1-3). Select 
Active Filters button to enter the online simulation test environment.

1.3.2 Filter Requirements Tab
Click the Filter Requirements tab and set desired parameters for the filter. (This tab is 
discussed in more detail in Chapter 3. “Filter Requirements”.)

FIGURE 1-5: Filter Requirements.
© 2008 Microchip Technology Inc. DS51666B-page 9
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1.3.3 Advanced Options Tab
Click the Advanced Options tab, configure the desired filter topology and set the 
specifications for the components to be used in the filter circuit. (This tab is discussed 
in more detail in Chapter 4. “Advanced Options”).

FIGURE 1-6: Advanced Options.
DS51666B-page 10 © 2008 Microchip Technology Inc.



Overview
1.3.4 Op Amp Selection Tab
Click the Op Amp Selection tab, choose an op amp to be used in the filter and click 
the corresponding Analyze link to start the next phase of the design. (This tab is 
discussed in more detail in Chapter 5. “Op Amp Selection”).

FIGURE 1-7: Op Amp Selection.
© 2008 Microchip Technology Inc. DS51666B-page 11
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1.3.5 Analyze Tab
There are four buttons associated with the Analyze tab:
• Interactive Schematic
• Reset Design
• Design Summary
• Downloads, Samples and More
The Mindi™ Active Filter Designer & Simulator generates the filter circuit schematic on 
this tab. For maximum design flexibility, changes in resistor and capacitor values can 
be implemented to fit the demands of the application. To run a simulation, choose a 
mode from the Select drop-down menu and click the Run button to simulate the 
schematic. Once the simulation is complete, waveforms will be available via the 
Waveforms drop-down menu. A single-page design summary can be generated by 
clicking Design Summary button. Moreover, the schematic, BOM, filter SPICE model 
and MindiTM offline version can be downloaded. (This tab is discussed in more detail in 
Chapter 6. “Analyze”).

FIGURE 1-8: Analyze.
DS51666B-page 12 © 2008 Microchip Technology Inc.
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Chapter 2.  Filter Design Tutorial
2.1 INTRODUCTION
This chapter steps users through the design of an example active filter circuit.

2.2 FILTER DESIGN EXAMPLE
Design a Butterworth low-pass filter with overall gain HM = +1 V/V, pass-band 
frequency fP = 1 kHz, stop-band frequency fS = 10 kHz, pass-band attenuation 
AP = 3 dB, stop-band attenuation AS = 80 dB.
The Butterworth low-pass filter can use the filter response template shown in 
Figure 2-1. Refer to Figure A-1 for a more complete template.

FIGURE 2-1: Filter Response Template for a Butterworth Low-Pass Filter.

Magnitude (dB) 

Transition
Band

Pass-band

Stop-band 

HM

HM – 3

HM – AS

BW fS Frequency (Hz)
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1. To access the Mindi™ Active Filter Designer & Simulator, refer to 
Section 1.2 “Accessing Mindi™” for more detail.

FIGURE 2-2: Active Filters.
DS51666B-page 14 © 2008 Microchip Technology Inc.



Filter Design Tutorial
2. Set Desired Parameters 
Click the Selectivity drop-down menu and specify low-pass in the selectivity 
pull-down menu. The Filter Characteristics dialog enables users to specify the 
approximation type, pass-band characteristics, stop-band characteristics, etc. 
There are three approximation types available: Butterworth, Bessel and Chebychev 
(For more detail about these three approximation types, see Appendix B. “Low-Pass 
Filter Approximations”). Click the Approximation drop-down menu and specify the 
filter approximation by Butterworth.
For Pass-band Characteristics, enter -3 in the Attenuation text box and enter 1k in the 
Frequency text box. For Stop-band Characteristics, enter -80 in the “Attenuation” box 
and enter 10k in the “Frequency text” box. (For more details about pass-band or 
stop-band characteristics, see Appendix A. “Filter Magnitude Templates”.)

FIGURE 2-3: Filter Requirements.

Note: The current version of Mindi requires negative values for the attenuations 
(e.g., AP and AS). For example, AP = 3 dB is entered as -3 in the 
Attenuation text box; AS = 80 dB is entered as -80 in the Attenuation 
textbox.This will be fixed in future versions.
© 2008 Microchip Technology Inc. DS51666B-page 15
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3. Configure the desired topology and set the specifications for the components to 
be used in the filter. 

The Topology drop-down menus include Sallen Key and Multiple Feedback (MFB) 
topologies for low-pass filter. The choice of circuit topology depends on performance 
requirements. The MFB has low sensitivity to component variations and better 
high-frequency behavior. The Sallen Key inherently has the suprerior gain accuracy at 
unity gain because its gain is not dependent on component values.
Here, Sallen Key topology is chosen for all stages. The Constraints text boxes enable 
users to specify the values of Power Supply Voltage, Maximum Output Voltage Swing 
and THD ceiling.

FIGURE 2-4: Advanced Options.
DS51666B-page 16 © 2008 Microchip Technology Inc.



Filter Design Tutorial
4. Select Op Amp
The Filter Characteristics table lists key filter design information as a reminder. The 
Recommended Op Amp table lists those op amps that come close to the recommended 
op amp specs. For more detail, see Appendix C. “Op Amp Selection”. For this 
tutorial, select MCP6001 by clicking the corresponding Analyze link.

FIGURE 2-5: Op Amp  Selection.
© 2008 Microchip Technology Inc. DS51666B-page 17
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5. Analyze
The Mindi™ Active Filter Designer & Simulator automatically generates the full 
schematic diagram of the filter circuit with recommended component values. There are 
two types of analysis in the Select drop-down menu: AC Analysis and Transient 
Analysis.
First, choose AC Analysis. Then, click the Configure button to set up the AC 
simulation condition. This pull-down menu allows the user to set up the start frequency, 
stop frequency and resolution. Finally, click the Run button to simulate the schematic. 
Once the simulation is completed, the AC response will be available via the 
Waveforms drop-down menu. Similarly, the Transient Analysis can be completed and 
the Step Response will also be available via the Waveforms drop-down menu. 
Moreover, a design summary can be generated by clicking Design Summary button. 
(See Figures 2-6 to 2-15).

FIGURE 2-6: AC Analysis and Transient Analysis.
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FIGURE 2-7: Configure the Simulation.

FIGURE 2-8: Running the Simulation.
© 2008 Microchip Technology Inc. DS51666B-page 19
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FIGURE 2-9: Simulation Complete.

FIGURE 2-10: View the Waveform.
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FIGURE 2-11: AC Response: Magnitude-Phase Delay.

FIGURE 2-12: AC Response: Magnitude-Group Delay.
© 2008 Microchip Technology Inc. DS51666B-page 21
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FIGURE 2-13: Step Response.

FIGURE 2-14: Design Summary.
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FIGURE 2-15: Downloads, Samples and More.
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NOTES:
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Chapter 3.  Filter Requirements
3.1 INTRODUCTION
This chapter discusses the Mindi Filter Requirements tab in greater detail. The Filter 
Requirements tab is shown in Figure 1-5 in Section 1.3.2. 

3.2 FILTER SELECTIVITY
The Selectivity drop-down menu enables the user to specify a filter type as Low-pass, 
High-pass and Band-pass.

FIGURE 3-1: Filter Selectivity.

3.3 FILTER DESCRIPTION
The Description table below the Selectivity pull-down menu describes the specified 
filter, as indicated in Figures 3-2 thru 3-4.

FIGURE 3-2: Low-Pass Filter Description.
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FIGURE 3-3: High-Pass Filter Description.

FIGURE 3-4: Band-Pass Filter Description.
DS51666B-page 26 © 2008 Microchip Technology Inc.



Filter Requirements
3.4 FILTER RESPONSE
1. Move the mouse to the filter response graph and click on it to enlarge.

FIGURE 3-5: Enlarge the Filter Response Graph.

Figure 3-6 thru Figure 3-8 provide a simplified representation of the filter responses 
and specification parameters. For all selectivities, AP and AS represent the pass-band 
and stop-band attenuations. HM represents the maximum transfer function magnitude. 
A detailed discussion is provided in Appendix A. “Filter Magnitude Templates”.

3.4.1 Low-Pass Filter
• fP = Pass-band Frequency; fS = Stop-band Frequency; BW = -3 dB Bandwidth

FIGURE 3-6: Filter Response and Parameter Definitions for Low-pass 
Selectivity.

Frequency (Hz) 

Pass Band

Stop Band 

Transition
Band

Magnitude (dB) 
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3.4.2 High-Pass Filter
• fP = Pass-band Frequency; fS = Stop-band Frequency; BW = -3 dB Bandwidth

FIGURE 3-7: Filter Response and Parameter Definitions for High-pass 
Selectivity.

3.4.3 Band-Pass Filter
• fPL = Lower Pass-band Frequency; fPU = Upper Pass-band Frequency 
• fSL = Lower Stop-band Frequency; fSU = Upper Stop-band Frequency
• BWL = Lower -3 dB Bandwidth; BWU = Upper -3 dB Bandwidth

FIGURE 3-8: Filter Response and Parameter Definitions for Band-pass 
Selectivity.
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Transition
           Band 
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3.5 FILTER CHARACTERISTICS
The Filter Characteristics dialog enables users to specify the Approximation type, Filter 
Order, Overall Filter Gain, Pass-band characteristics and Stop-band characteristics.

3.5.1 Approximation
The Approximation drop-down menu specifies three most commonly used filter 
approximations: Butterworth, Bessel and Chebyshev. A detailed discussion about the 
differences between these approximations is provided in Appendix B. “Low-Pass 
Filter Approximations”.
 

FIGURE 3-9: Filter Approximation.

3.5.2 Overall Filter Gain
• For a Butterworth, Bessel and some Chebyshev approximations, the overall filter 

gain (G) is set as HM as shown in Figure 3-6 through Figure 3-8. This setting is 
reflected in Figure 3-10 and Figure 3-11.

• For other Chebychev Approximation: Low-pass of even order, High-pass of even 
order and Band-pass of orders 4 and 8, the overall filter gain (G) is set as HM - AP 
as shown in Figure 3-6 through Figure 3-8. This setting is reflected in Figure 3-12 
and Figure 3-13.

The allowable range of overall filter gain is 1 V/V to 10 V/V.
 

FIGURE 3-10: Overall Filter Gain For Butterworth.
.

FIGURE 3-11: Overall Filter Gain For Bessel.

Note: Bessel is available only when Low-pass is selected.
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FIGURE 3-12: Overall Filter Gain For Chebychev.

FIGURE 3-13: Chebychev Filter Notes.
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3.5.3 Filter Order
The Filter Order drop-down menu allows users to specify the filter order, if desired.
By default, the Force checkbox is unselected, and users only need to specify the 
characteristics of Pass-band and Stop-band. The Mindi™ Active Filter Designer will 
automatically calculate the best filter order according to the characteristics of 
pass-band and stop-band specified by users. The calculated filter order will be the 
minimum order that meets or exceeds the required stop-band attenuation.
When the Force checkbox is selected, the Stop-band characteristics text boxes will be 
disabled. In this case, users only need to specify the filter order and Pass-band 
characteristics.
Band-pass selectivity only permits an even filter order. Therefore, the order will 
increment by two when the Band-pass selectivity is selected.

FIGURE 3-14: Filter Order.

FIGURE 3-15: Filter Characteristics with Force Filter Order Selected.
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FIGURE 3-16: Filter Characteristics with Bessel Approximation Selected.

Note: Bessel approximations only support forced filter orders. When the Bessel 
approximation is selected, the Force checkbox will be selected and 
disabled.
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3.5.4 Pass-band and Stop-band Characteristics
The Pass-band and Stop-band characteristics text boxes allow users to modify the 
filter circuit parameters. For all selectivities, AP represents the Pass-band attenuations 
and AS represents the Stop-band attenuations. For Low-pass selectivities, fP 
represents the Pass-band frequencies and High-pass selectivities, fS represent the 
Stop-band frequencies.

FIGURE 3-17: Pass-band and Stop-band Characteristics for Low-pass and 
High-pass Filters.

For Band-pass selectivity, fPU and fPL represent the Pass-band upper and lower 
frequencies, while fSU and fSL represent the Stop-band upper and lower frequencies.

FIGURE 3-18: Pass-band and Stop-band Characteristics for Band-pass Filter.

Note: The current version of Mindi requires negative values for the attenuations 
(e.g., AP and AS). For example, AP = 3 dB is entered as -3 in the 
“Attenuation text” boxes; AS = 80 dB is entered as -80 in the “Attenuation” 
text box.
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3.5.4.1 PASS-BAND ATTENUATION

The Pass-band Attenuation is the change in magnitude of the frequencies in the Pass-
band. The Pass-band attenuation for each selectivity (Low-pass, High-pass, 
Band-pass) is shown in Figure 3-6 thru Figure 3-8. The allowable range is -0.01 dB to 
-3 dB.

3.5.4.2 STOP-BAND ATTENUATION

The Stop-band attenuation is the minimum reduction in magnitude of the frequencies 
in the Stop-band relative to the pass-band. The Stop-band attenuation for each 
selectivity is shown in Figure 3-6 thru Figure 3-8. The allowable range is -10 dB to 
-100 dB. 

3.5.4.3 PASS-BAND FREQUENCY

The Pass-band frequency is the starting point of the Pass-band, as shown in Figure 3-6 
thru Figure 3-8. The allowable range is 0.1 Hz to 1 MHz. 
• For a Low-pass filter, the Pass-band frequency must be lower than the Stop-band 

frequency for Low-pass selectivity.
• For a High-pass filter, the Pass-band frequency must be greater than the 

Stop-band frequency for High-pass selectivity.
• For a Band-pass filter, the lower Pass-band frequency must be lower than the 

upper Pass-band frequency and both Stop-band frequencies for Band-pass 
selectivity.

3.5.4.4 STOP-BAND FREQUENCY

The Stop-band frequency is the starting point of the Stop-band, as shown from 
Figure 3-6 thru Figure 3-8. The allowable range is 0.1 Hz to 1 MHz. 
• For a Low-pass filter, the Stop-band frequency must be greater than the 

Pass-band frequency for Low-pass selectivity.
• For a High-pass filter, the Pass-band frequency must be greater than the 

Stop-band frequency for High-pass selectivity.
• For a Band-pass filter, the lower Pass-band frequency must be lower than the 

upper Pass-band frequency and both Stop-band frequencies for Band-pass 
selectivity.

3.5.5 Reset
The Reset button on the lower left of the window allows the user to reset any changes 
made to the Filter Characteristics text boxes to their initial settings.

3.5.6 Advanced Options
After setting the desired parameters for the filter, click on the Advanced Options 
button to configure the topologies, specify component tolerances, and set the Op Amp 
constraints.

Note: When the Bessel approximation is selected, the Pass-band Attenuation is 
forced to -3 dB.
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Chapter 4.  Advanced Options
4.1 INTRODUCTION
This chapter discusses the Mindi Advanced Options tab in greater detail. The 
Advanced Options tab is shown in Figure 1-6 in Section 1.3.3. This tab allows users 
to specify the circuit topology for each filter stage and set the rules for component 
selection.

4.2 TOPOLOGY SELECTION
The circuit topologies supported are the Sallen Key and Multiple Feedback (MFB). The 
Low-pass filters can use either the Sallen Key or MFB, the Band-pass filter is available 
with the MFB and the High-pass filter uses the Sallen Key. The choice of circuit 
topology for Low-pass filter depends on performance requirements. The MFB has low 
sensitivity to component variations and superior high-frequency behavior. The Sallen 
Key inherently has the superior gain accuracy at unity gain because its gain is not 
dependent on component values. For more information, refer to the filter textbooks 
listed in Appendix E. “Selected References”.

FIGURE 4-1: Topologies Selection.

Note: For Low-pass filters, changing the topology only affects the selected stage.
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4.3 RESISTOR SELECTION
The Resistor Selection allows users to select the tolerance of the resistors used in the 
filter circuit or use the exact calculated value. Changing the Resistor Selection affects 
all stages of the filter circuit. The resistor selection defaults to E96 allowing off-the-shelf 
components to be specified in the filter circuit solution.

FIGURE 4-2: Resistors Selection with Tolerance.

4.4 CAPACITOR SELECTION
The Capacitor Selection allows users to select the tolerance of the capacitors used in 
the filter circuit or use the exact calculated value. Changing the Capacitor Selection 
affects all stages of the filter circuit. The capacitor selection defaults to E12 allowing 
off-the-shelf components to be specified in the filter circuit solution.

FIGURE 4-3: Capacitors Selection with Tolerance.

Note: “E96” is a preferred number series specified in IEC 60063. The number 
following the “E” indicates how many standardized (commercially) available 
values exist in each decade (e.g., between 10 and 100, or between 100 and 
1000). So, resistors conforming to “E96” have 96 distinct values between 
10 and 100. 

Note: “E12” is a preferred number series specified in IEC 60063. The number 
following the “E” indicates how many standardized (commercially) available 
values exist in each decade (e.g., between 10 and 100, or between 100 and 
1000). So, capacitors conforming to “E12” have 12 distinct values between 
10 and 100. 
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4.5 OP AMP CONSTRAINTS
The Op Amp Constraints text boxes allow users to specify the values for:
• Power Supply Voltage (VDD)

VDD is the filter’s nominal single supply voltage with a range of 1.4V to 5.5V and 
dual supply voltages need to be converted to an equivalent single supply value.

• Maximum Output Voltage Swing (Vswing)
Vswing is the maximum expected voltage swing at any filter op amp’s output with 
a range of 0 V to VDD.

• THD Ceiling
THD Ceiling is the maximum harmonic (non-linear) distortion allowed in the 
application with a range of -100 dBc to -40 dBc.

.

FIGURE 4-4: Op Amp Constraints.

After configuring the desired topology and setting the specifications for the 
components, click the Op Amp Selection tab to select the op amp to be used in this 
filter.
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Chapter 5.  Op Amp Selection
5.1 INTRODUCTION
This chapter discusses the Mindi Op Amp Selection tab in greater detail. The Op Amp 
Selection tab is shown in Figure 1-7 in Section 1.3.4. This tab allows the user to 
specify which Microchip op amp is used in the active filter circuit.

5.2 RECOMMENDED OP AMPS
Five tables are provided in this tab as indicated in Figure 5-1:
1. The Filter Characteristics table lists the key filter design information as a 

reference.
2. The Op Amp Design Constraints and Recommended Op Amp Parameters 

tables show the recommended op amp specifications for the filter design.
3. The Recommended Op Amps table lists those op amps that come close to the 

recommended op amp specifications. The ideal op amp list at the top is included 
for comparing simulation results to textbook filter responses.

4. The Other Op Amps table lists other op amps that are not as close to the 
recommended op amp specifications. The specifications that do not meet 
recommendations are indicated in red.

Once the op amp has been selected, click the corresponding Analyze link, the Mindi™ 
Active Filter Designer & Simulator can generate and simulate the schematic of the filter 
circuit.
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FIGURE 5-1: Op Amp Selection.

5.3 OP AMP SPECIFICATIONS
The following specificitions are shown to help the designer choose the right op amp.
1. Gain Bandwidth Product:

The product of op amp open-loop gain times the frequency at any point where 
the amplifier response is attenuating at a rate of -20 dB/decade of frequency.

2. Slew Rate:
The maximum rate of change at the output of an op amp. Basically, says how fast 
the output can “follow” the input.

3. Power Supply Voltage:
The acceptable supply voltage which allows the linear operation of an op amp.

4. Quiescent Current (Iq):
The amount of current consumed by op amp when it is not performing any work 
(idle).
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5. Rail-to-Rail Input/Output:
The op amp will operate correctly when its input/output is closely driven to either 
power rail under defined operating conditions. (N means No and Y means Yes).

A detailed discussion of the op amp selection algorithms and criteria are provided in 
Appendix C. “Op Amp Selection”.
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Chapter 6.  Analyze
6.1 INTRODUCTION
This chapter discusses the Mindi Analyze tab in greater detail. The Analyze tab is 
shown in Figure 1-8 in Section 1.3.5. This tab includes four buttons which are 
Interactive Schematic, Reset Design, Design Summary and Downloads, Samples 
and More. 

6.2 INTERACTIVE SCHEMATIC

6.2.1 Schematic Viewer
The Mindi™ Active Filter Designer & Simulator automatically generates the full 
schematic view of the filter circuit with recommended component values. The individual 
components of the schematic can be modified, allowing users to further evaluate the 
design solution. Various Simulation operations can also be selected in order to analyze 
and evaluate the performance of the filter circuit. Detailed help on using the Schematic 
Viewer can be accessed via the Help button.

FIGURE 6-1: Schematic Viewer.
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6.2.2 Edit Component Value 
The value of a component (resistor or capacitor) can be changed from its default value 
calculated by the Mindi™ Active Filter Designer & Simulator. Changing the component 
value only affects the component that is selected. To modify a component value, click 
on the component to access its attributes window, as shown in Figure 6-2 through 
Figure 6-5.
• Database Tab: Contains recommended parts to use with this circuit. Users can 

click on the header of any column to sort the database by that column. 
Columnwidths can also be adjusted by dragging the boundary between columns.

• Custom Tab: Enter custom parameter for this component.

The allowable range of capacitance is from 1.0 pF to 10 µF. 
The allowable range of resistance is from 0Ω to 1.0 GΩ.

.

Note 1: 0Ω , 1.0 GΩ, 1.0 pF, and 10 µF are intended for simulation purposes and 
is not practical in real applications.

2: To remove parts from the schematic for simulation purposes, use 1.0 GΩ 
for shunt resistors and 0Ω for series resistor, and use 1.0 pF for shunt 
capacitors and 10 µF for series capacitors.

Note: It is the user’s responsibility to ensure the proper filter behavior when 
component values are changed.
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FIGURE 6-2: Edit Capacitor: Database Tab.

FIGURE 6-3: Edit Capacitor. Custom Tab.
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FIGURE 6-4: Edit Resistor: Database Tab.

FIGURE 6-5: Edit Resistor: Custom Tab.
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6.2.3 Edit Op Amp
The type of op amp can also be changed. Changing the type of op amp only affects the 
op amp that is selected as shown in Figure 6-6. To change the op amp, move the 
mouse the appropriate op amp, then left-click the mouse. A dialog box will appear and 
the user can select the type of op amp and click OK.

FIGURE 6-6: Edit Op Amp.

Note: It is user’s responsibility to ensure the proper filter behavior when the op 
amp is changed.
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6.2.4 Select Analysis
Two types of analysis can be selected in the Select drop-down menu: AC Analysis 
and Transient Analysis.
• AC Analysis or frequency-domain analysis is used mainly in connection with 

amplifiers and filters, where the frequency response is of interest. The AC 
simulation is usually based on a sweep over a range of frequencies. In the real 
world, this kind of measurement would be made with a network analyzer

• Transient Analysis or time-domain analysis most closely simulates the 
phenomena seen in the real circuit by means of an oscilloscope. A simulation 
consists usually of a time sweep starting at t = 0

6.2.4.1 AC ANALYSIS 

AC Analysis can be chosen from the Select drop-down menu.

FIGURE 6-7: Select AC Analysis.
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6.2.4.1.1 Configure Simulation
The Configure Simulation text box allows users to set up the start frequency, stop 
frequency and resolution for AC Analysis.
• The allowable range of start and stop frequencies: 0.001  Hz to 100 MHz
• The allowable range of resolution: 1  point/decade to 10000 points/decade

FIGURE 6-8: Configure Simulation: AC Analysis.

6.2.4.2 RUN SIMULATION

Click the Run button to start the simulation. A Simulation Complete dialog box pops up 
when the simulation is complete. Click the OK button to view the waveforms. (See 
Figure 6-9 and Figure 6-10).

FIGURE 6-9: Run Simulation.
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FIGURE 6-10: Simulation Complete.

6.2.4.3 VIEW WAVEFORMS

The Waveforms drop-down menu includes two kinds of waveforms: 
• Magnitude - Group Delay
• Magnitude - Phase

Note 1: Group Delay is a measure of frequency domain response of the active 
filter. It focuses on the relative time delay among sine waves of nearly 
equal frequency.

2: Magnitude means the magnitude response of the filter transfer function, 
which is the overall filter gain.

3: Phase means the phase response of the filter transfer function, which is 
the overall filter phase shift.
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FIGURE 6-11: View Waveforms.

6.2.4.3.1 Magnitude - Group Delay
Magnitude - Group Delay can be chosen in the View Waveforms drop-down menu. 
The y-axes display the magnitude of the overall filter gain function and the group delay 
of the filter. The x-axis displays the frequency.
Two sets of simulation data are shown: the response using an ideal op amp model, and 
the response using the selected op amp’s model.

FIGURE 6-12: Magnitude - Group Delay Waveform.
© 2008 Microchip Technology Inc. DS51666B-page 51



Mindi™ Active Filter Designer User’s Guide
M1 or M2 can be moved horizontally to a desired frequency value. Or, double click M1 
or M2 and a dialog box will appear and the user can input a frequency value to force 
the marker to that value. (See Figure 6-13). 
After the frequency value is set for M1 and M2, the values of magnitude, group delay, 
ideal magnitude and ideal group delay will be updated. When the checkbox is not 
selected, the filter response will not display the related waveforms.
Also worth noting are the buttons in the upper left hand corner of the window (zoom in, 
zoom out, magnifier, hand tool, reset view and print) that allow the waveform view to 
be changed or printed. Detailed help can be accessed via the Help button.

FIGURE 6-13: Set Value for Markers.

6.2.4.3.2 Magnitude - Phase
Magnitude - Phase can be chosen in the Waveforms drop-down menu. The y-axes 
displays the magnitude of overall filter gain and the phase shift between VOUT and VIN. 
The x-axis displays the frequency.
Two sets of simulation data are shown: the response using an ideal op amp model, and 
the response using the selected op amp’s model.
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FIGURE 6-14: Magnitude - Phase Waveform.

Magnitude - Phase waveform has the same user interface as Magnitude - Group Delay 
waveform. (Section 6.2.4.3.1)
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6.2.4.4 TRANSIENT ANALYSIS

Transient Analysis can be chosen from the Select drop-down menu.

FIGURE 6-15: Transient Analysis.

6.2.4.5 CONFIGURE SIMULATION

The Configure Simulation text boxes allows the user to set up the start time and stop 
time for the Transient Analysis. The allowable range of Stop Time: 1 us to 100s.

FIGURE 6-16: Configure Simulation: Transient Analysis.
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6.2.4.6 RUN SIMULATION

Click the Run button to start the simulation. A Simulation Complete dialog pops up 
when the simulation is complete. Click the OK button to view the waveforms. 

FIGURE 6-17: Run  imulation.

FIGURE 6-18: Simulation Complete.
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6.2.4.7 VIEW WAVEFORMS

Click the Waveform drop-down menu and select Step Response.

FIGURE 6-19: Waveforms.

6.2.4.7.1 Step Response
The y-axis displays the voltage of the step response. The x-axis displays the time.

FIGURE 6-20: Step Response.

Step Response waveform has the same user interface as Magnitude-Group Delay 
waveform. For more information, refer to Section 6.2.4.3.1.
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6.3 RESET DESIGN
Click the Reset Design button to restore schematic to the original application circuit 
that was generated from the user’s inputs on the Input Requirements page. This action 
will reset all component values back to their default values.

FIGURE 6-21: Reset Design.

6.4 DESIGN SUMMARY
Click the Design Summary button to display or print a single page summary of the 
application circuit solution, including Input Requirements, Schematic, Simulation 
Waveforms and Bill of materials (BOM).

FIGURE 6-22: Design Summary.
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6.5 DOWNLOADS, SAMPLES AND MORE
Click the Downloads, Sample and More button to download tools and materials which 
includ the schematic, BOM, filter SPICE model and Mindi™ offline version. Users also 
can directly link to Microchip’s device web pages, sample/order a device, order an 
evaluation board.

FIGURE 6-23: Downloads, Samples and More.
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Appendix A. Filter Magnitude Templates
A.1 INTRODUCTION
This chapter provides additional information on the Low-pass, Band-pass, and 
High-pass filter templates used in the Mindi™ Active Filter Designer & Simulator.

A.2 FILTER MAGNITUDE RESPONSES

A.2.1 LOW-PASS FILTER MAGNITUDE RESPONSE
The magnitude response of Low-pass filters is shown in Figure A-1.

FIGURE A-1: Low-pass Filter Template.

The nominal filter response is required to stay within the three regions: Pass-band, 
Transition band and Stop-band. The relevant parameters for the three regions and the 
controlling inequalities are:
• Pass-band  

0 ≤ f ≤ fP
0 ≤ A ≤ AP
Where:
HM = Maximum Transfer Function Magnitude (dB)
A = Attenuation (relative to HM) (dB)
AP * = Pass-band Ripple/Max. Attenuation (dB)
fP * = Pass-band Frequency (Hz)
BW = -3 dB Bandwidth
* sometimes referred to as cut-off

Frequency (Hz) 

Pass Band

Stop Band 

Transition
Band

Magnitude (dB) 
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• Transition Band

• Stop-band

The gain parameter (G) in the Mindi™ Active Filter Designer & Simulator corresponds 
to the DC gain (for good sensitivity performance). Thus:

The limits that Mindi™ Active Filter Designer & Simulator enforces on these Low-pass 
parameters are:

fP ≤ f ≤ fS
AP ≤ A ≤ AS
Where:
fP = Pass-band Frequency (Hz)
fS = Stop-band Edge Frequency (Hz)
AP = Pass-band Ripple/Max. Attenuation (dB)
A = Attenuation (relative to HM) (dB)
AS = Minimum Stop-band Attenuation (dB)

fS ≤ f
AS ≤ A
Where:
fS = Stop-band Edge Frequency (Hz)
AS = Minimum Stop-band Attenuation (dB)
A = Attenuation (relative to HM) (dB)

G = HM; Bessel, Butterworth and Chebychev (n = 1, 3, 5, 7)
G = HM - AP; Chebychev (n = 2, 4, 6, 8)

0.1 Hz  ≤ fP < fS  ≤ 1.0 MHz
AP = 3.0 dB, Bessel Filters
0.01 dB  ≤ AP  ≤ 3.0 dB, Butterworth and Chebychev
10 dB  ≤ AS  ≤ 100 dB
1 V/V  ≤ G  ≤ 10 V/V, (0 dB to 20 dB)

Note: The current version of Mindi requires negative values for the attenuations 
(e.g., AP and AS). For example, AP = 3 dB is entered as -3 in the 
Attenuation text box. AS = 80 dB is entered as -80 in the Attenuation text 
box.
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A.2.2 BAND-PASS FILTER MAGNITUDE RESPONSE
The magnitude response of Band-pass filters is shown in Figure A-2.

FIGURE A-2: Band-pass Filter Template.

The nominal filter response is required to stay within the five regions shown 
(Pass-band, two transition bands and two Stop-bands). The relevant parameters for the 
three regions and the controlling inequalities are:
• Lower Stop-band

• Lower Transition Band

f ≤ fSL
AS ≤ A
Where:
fSL = Lower Stop-band Edge Frequency (Hz)
AS = Minimum Stop-band Attenuation (dB)
A = Attenuation (relative to HM) (dB)
HM = Maximum Transfer Function Magnitude (dB)

fSL < f < fPL
AP < A < AS
Where:
fSL = Lower Stop-band Edge Frequency (Hz)
fPL * = Lower Pass-band Frequency (Hz)
AP = Pass-band Ripple/Max. Attenuation (dB)
A = Attenuation (relative to HM) (dB)
AS = Minimum Stop-band Attenuation (dB)

Magnitude (dB) 

Pass Band

Transition
           Band 

Transition
Band

Stop Band Stop Band

Frequency (Hz) 
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• Pass-band

• Upper Transition Band

• Upper Stop-Band

The gain parameter (G) in the Mindi™ Active Filter Designer & Simulator corresponds 
to the mid-band gain (for ease of implementation), where:

Thus,

The limits that Mindi™ Active Filter Designer & Simulator enforces on these band-pass 
parameters are:

The current version of Mindi requires negative values for the attenuations (e.g., AP and 
AS). For example, AP = 3 dB is entered as -3 in the Attenuation text box. AS = 80 dB is 
entered as -80 in the Attenuation text box.

fPL ≤ f ≤ fPU
0 ≤ A ≤ AP
Where:
fPL * = Lower Pass-band Frequency (Hz)
fPU * Upper Pass-band Frequency (Hz)
A = Attenuation (relative to HM) (dB)
AP * = Pass-band Ripple/Max. Attenuation (dB)
* sometimes referred to as cut-off

fPU < f < fSU
AP < A < AS
Where:
fPU * = Upper Pass-band Frequency (Hz)
fSU = Upper Stop-band Edge Frequency (Hz)
AP * = Pass-band Ripple/Max. Attenuation (dB)
AS = Min. Stop-band Attenuation (dB)
* sometimes referred to as cut-off

fSU ≤ f
AS ≤ A
Where:
fSU = Upper Stop-band Edge Frequency (Hz)
AS = Min. Stop-band Attenuation (dB)

f0 = Mid-band Frequency
= (fPL fPU)1/2

G = HM; Bessel, Butterworth and Chebychev (n = 2, 6)
G = HM - AP; Chebychev (n = 4, 8)

0.1 Hz  ≤ fSL < fPL  < fPU < fSU ≤ 1.0 MHz
1.2210 ≤ fPU/fPL ≤ 5.8284
0.01 dB  ≤ AP  ≤ 3.0 dB
10 dB  ≤ AS  ≤ 100 dB
1 V/V  ≤ G  ≤ 10 V/V, (0 dB to 20 dB)
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A.2.3 HIGH-PASS FILTER MAGNITUDE RESPONSE
The magnitude response of High-pass filters is shown in Figure A-3.

FIGURE A-3: High-pass Filter Template.

The nominal filter response is required to stay within the three regions shown 
(Pass-band, Transition Band and Stop-band). The relevant parameters for the three 
regions and the controlling inequalities are:
•  Pass-band

• Transition Band

fP ≤ f
0 ≤ A ≤ AP
Where:
fP * = Pass-band Frequency (Hz)
BW = -3 dB Bandwidth
HM = Maximum Transfer Function Magnitude (dB)
A = Attenuation (relative to HM) (dB)
AP * = Pass-band Ripple/Max. Attenuation (dB)
* sometimes referred to as cutoff

fS < f < fP
AP < A < AS
Where:
fS = Stop-band Edge Frequency (Hz)
fP * = Pass-band Frequency (Hz)
AP * = Pass-band Ripple/Max. Attenuation (dB)
A = Attenuation (relative to HM) (dB)
AS = Minimum Stop-band Attenuation (dB)
* sometimes referred to as cutoff

Magnitude (dB) 

Pass Band 
 Transition 

  Band

  Stop Band

Frequency (Hz) 
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• Stop-band

The gain parameter (G) in the Mindi™ Active Filter Designer & Simulator corresponds 
to the high frequency gain (at "infinity" for good sensitivity performance). Thus:

The limits that the Mindi™ Active Filter Designer & Simulator enforces on these 
High-pass parameters are:

f ≤ fS
AS ≤ A
Where
fS = Stop-band Edge Frequency (Hz)
AS = Minimum Stop-band Attenuation (dB)
A = Attenuation (relative to HM) (dB)

G = HM; Bessel, Butterworth and Chebychev (n = 1, 3, 5, 7)
G = HM - AP; Chebychev (n = 2, 4, 6, 8)

0.1 Hz  ≤ fS < fP ≤ 1.0 MHz
0.01 dB  ≤ AP  ≤ 3.0 dB
10 dB  ≤ AS  ≤ 100 dB
1 V/V  ≤ G  ≤ 10 V/V, (0 dB to 20 dB)

Note: The current version of Mindi requires negative values for the attenuations 
(e.g., AP and AS). For example, AP = 3 dB is entered as -3 in the 
Attenuation text box. AS = 80 dB is entered as -80 in the Attenuation text 
box.
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Appendix B. Low-Pass Filter Approximations
B.1 INTRODUCTION
The Mindi™ Active Filter Designer & Simulator supports three most commonly used 
filter approximations: Butterworth, Bessel and Chebyshev. The tool allows the design 
of Low-pass filters with Chebychev, Bessel or Butterworth. It also allows design 
Band-pass and High-pass filters with Chebychev and Butterworth responses.
Let’s choose the Low-pass filter with 6th order as an example and discuss the 
difference between these approximations.

B.1.1 Butterworth Low-pass Approximation
It has the following characteristics:
• Maximally-flat-magnitude-response filters, optimized for gain flatness in the 

Pass-band. Above the pass-band frequency the attenuation is 
-20 dB/decade/order (Figure B-1)

• Moderate group delay response (Figure B-2)
• Moderate overshoot and ringing in the step response (Figure B-3)
The magnitude - phase response of the 6th order Low-pass filters with Butterworth 
approximation is shown in Figure B-1.

FIGURE B-1: Magnitude - Phase Response.

The magnitude - group delay response of the 6th order Low-pass filters with 
Butterworth approximation is shown in Figure B-2.
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FIGURE B-2: Magnitude - Group Delay Response

The step response of the 6th order Low-pass filters with Butterworth approximation is 
shown in Figure B-3.

FIGURE B-3: Step Response.
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B.1.2 Bessel Low-pass Approximation
It has the following Low-pass characteristics:
• Moderate magnitude response and the attenuation above pass-band frequency 

which is not as steep as a Butterworth response of the same order. (Figure B-4)
• Maximally flat group delay or linear phase response (Figure B-5)
• Minimal overshoot and ringing in the step response (Figure B-6)
The magnitude - phase response of the 6th order Low-pass filters with Bessel 
approximation is shown in Figure B-4.

FIGURE B-4: Magnitude - Phase Response with Bessel Approximation.

The magnitude - phase response of the 6th order Low-pass filters with Bessel 
approximation is shown in Figure B-5.
© 2008 Microchip Technology Inc. DS51666B-page 67



Mindi™ Active Filter Designer User’s Guide
FIGURE B-5: Magnitude - Group Response with Bessel Approximation.

The step response of the 6th order Low-pass filters with Bessel approximation is shown 
in Figure B-6.

FIGURE B-6: Step Response with Bessel Approximation.
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B.1.3 Chebyshev Low-pass Approximation
It has the following Low-pass characteristics:
• Amplitude variation (ripple) in the Pass-band, but steeper roll-off above the 

pass-band frequency than Butterworh and Bessel (Figure B-7)
• Poor group delay or phase response (Figure B-8)
• More overshoot and ringing in the step response than Butterworth and Bessel 

(Figure B-9)
The magnitude - phase response of the 6th order Low-pass filters with Chebyshev 
approximation is shown in Figure B-7.

FIGURE B-7: Magnitude - Phase Response with Chebyshev Approximation.

The magnitude - group response of the 6th order Low-pass filters with Chebyshev 
approximation is shown in Figure B-8.
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FIGURE B-8: Magnitude - Group Delay Response with Chebyshev 
Approximation.

The step response of the 6th order Low-pass filters with Chebyshev approximation is 
shown in Figure B-9.

FIGURE B-9: Step Response with Chebyshev Approximation.
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B.1.4 Summary of Low-pass Filter Responses

TABLE B-1: FILTER APPROXIMATION SUMMARY (NOTE 1 THRU NOTE 3)

Approximations

Frequency Domain Time Domain

Gain Flatness in 
Pass-band

Group Delay Flatness 
in Pass-band

Transition from 
Pass-band to 

Stop-band
Overshoot Ringing

Bessel Moderate Good Poor Good Good
Butterworth Good Moderate Moderate Moderate Moderate
Chebyshev Poor Poor Good Poor Poor

Note 1: Bessel approximation only supports Low-pass filter.
2: Overshoot is the amount which output voltage exceeds its target value.
3: Ringing is an unwanted oscillation of a voltage or current.
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NOTES:
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Appendix C. Op Amp Selection
C.1 INTRODUCTION

C.1.1 OP AMP SMALL SIGNAL BANDWITH
The op amps selected for your filter need to be fast enough to avoid problems with 
non-linear distortion and filter response distortion. A crude estimate of the op amp 
GBWP (Gain Bandwidth Product) that you need for a filter section is:

Try op amps with different GBWPs to see what you require. Small signal frequency 
response (typically VOUT < 100 mVP-P) starts to peak as the GBWP goes too low. 
Harmonic distortion also grows as the GBWP goes lower.

C.1.2 OP AMP FULL-POWER BANDWIDTH
The op amps also need to handle large signals. The SR (Slew Rate) specified in the op 
amp data sheets is related to the full-power bandwidth as follows.

Sine waves faster than fFPBW will not be faithfully reproduced because their derivative 
(slew rate) is too high.

GBWP = HM 100 fP, Low-pass
= HMQ 100 fPU, Band-pass
= HMmax {100 fP, fmax}, High-pass

Where:
HM = Filter section's maximum gain (V/V)
fP = Low-pass and High-pass filters’ Pass-band frequency (Hz)
fPU = Band-pass filter's upper Pass-band frequency (Hz)
Q = Band-pass filter's overall Q-factor

= 1/"fractional bandwidth"
= (fPL fPU)1/2/(fPU - fPL)

fmax = Maximum Pass-band/signal frequency for High-pass 
response >> fP

fFPBW = SR/(πVOUT_P-P) (Hz)
Where:
VOUT_P-P = Filter section's maximum output voltage swing 

(VP-P) < VDD – VSS
SR = Slew rate (V/s); data sheets usually give units of V/µs

(1 V/µs = 1,000,000 V/s)
fFPBW = op amp full-power bandwidth (Hz)
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In order to keep harmonic (non-linear) distortion to a minimum, the recommended 
minimum SR for all op amps in the filter is:

Note that non-linear distortion may include a DC offset term.

C.1.3 OP AMP OUTPUT LOADING
Choose the resistance values in your filter so that the op amp is not overloaded. 
A compromise among loading, noise and parasitic RC time constants needs to be 
made. To scale the resistor values, change the capacitor values in the Filter Circuit 
Schematic within the Mindi.

C.1.4 MINIMUM GAIN
Most op amps are unity gain stable (G ≥ +1 V/V). A few op amps need to be set at 
higher gains to remain stable (e.g., G ≥ +10 V/V for the MCP6141). If you need gain in 
your filter, this kind of part can give you the bandwidth and the gain you need with less 
quiescent current. Note that inverting gains, used in Multiple Feedback (MFB) sections, 
have an equivalent "noise gain" that is used to determine stability. It is calculated as:

1 +  |G| (e.g., a signal gain of -1 V/V gives a noise gain of +2 V/V).

SR = XFF π VOUT_P-P fP, Low-pass
= XFF π VOUT_P-P fPU, Band-pass
= XFF π VOUT_P-P fmax, High-pass

Where:
fP = Low-pass and High-pass filters' Pass-band frequency (Hz)
fPU = Band-pass filter's upper Pass-band frequency (Hz)
fmax Maximum Pass-band/signal frequency for High-pass response 

>> fP
XFF = rough fudge factor for distortion performance (relative to 

fundamental)
≈ 2, THDSR = -60 dBc
≈ 4, THDSR = -72 dBc
≈ 8, THDSR = -84 dBc
≈ 16, THDSR = -96 dBc

THDSR = Slew Rate induced distortion level (dBc)
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Appendix D. Group Delay
D.1 INTRODUCTION
Group Delay is a measure of frequency domain response. It focuses on the relative 
time delay among sine waves of nearly equal frequency. Its usual definition is:

An equivalent definition, when frequency is in Hz and phase is in degrees, is:

Figure D-1 and Figure D-2 illustrate phase and group delay.

FIGURE D-1: Low-pass Phase Response.

Ω = Radian Frequency (rad/s)
φ(ω) = Phase Response (rad)

= atan(Im{G}/Re{G})
τgd(ω) = group delay (s)

= -dφ(w)/dω

f = Frequency (Hz = cycles/s)
φ(f) = Phase Response (°)

= atan(Im{G}/Re{G})
τgd(f) = group delay (s)

= (1 cycle/360°) (-dφ(f) / df)
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FIGURE D-2: Low-pass Group Delay.

Some reasons that group delay has been traditionally used for filter work are:
• It is easier to manipulate mathematically (no arc-tangent functions)
• Group delay is easier to optimize:

- Its jump discontinuities are only at transmission zeros on the jω-axis (gain is 
zero)

- It is a non-negative function for Low-pass filters
• It applies directly to AM modulated signals:

- The information is delayed by the group delay (also known as envelope delay)
- It maps directly to group delay at baseband
- The carrier is delayed by a different time (total phase shift divided by carrier 

frequency)
• It is a good indicator of Low-pass step response quality:

- Constant group delay in the pass-band, and well into the Transition band 
(A < 10 dB to 20 dB), indicates a very good step response

- Group delay with peaking (usually near fP) indicates overshoot and ringing
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Appendix E. Selected References
E.1 INTRODUCTION

E.1.1 FILTER TEXTBOOKS AND CLASSIC REFERENCES
[1] Arthur B. Williams and Fred J. Taylor, Electronic Filter Design Handbook, 3rd ed., 

McGraw-Hill, 1995.
[2] Rolf Schaumann, M.S. Ghausi, and Kenneth R. Laker, Design of Analog Filters: 

Passive, Active RC, and Switched Capacitor, Prentice Hall, 1990.
[3] Andreas Antoniou, Digital Filters: Analysis and Design, McGraw-Hill, 1979.
[4] Anatol I. Zverev, Handbook of Filter Synthesis, Wiley, John & Sons, 1967.
[5] Rolf Schaumann, Mac E. Van Valkenburg, and Mac Van Valkenburg, Design of 

Analog Filters, 2nd ed., Oxford University Press, 2001.

E.1.2 APPLICATION NOTES
[1] Bonnie Baker, Anti-Aliasing, Analog Filters for Data Acquisition Systems, 

Application Note 699, DS00699, Microchip Technology Inc., 1999.
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